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CHAPTER I 

INTRODUCTION 
 

 
 In today’s competitive environment it has become essential to reduce the cost. 

The most effective way to reduce cost is by reducing the raw material consumption. 

However the reduction in the raw material consumption should be carried out after 

proper planning and analysis so that there is no problem during the manufacturing 

stage. This becomes even more important in the industries in which raw materials form 

a large proportion of the cost of the finished product. The most common are the 

garment, ship-building and railway coach manufacturing industries. 

 It has been decided in this project work to carry out work on analyzing and 

validating the designed model of the parts under consideration for various stresses 

developed due to the different loading conditions. After analysis of the 3-D models of 

the parts then material consumption minimization has been done to reduce the amount 

of raw material sheets used for cutting the parts out of rectangular stocks. The parts 

under consideration are the C-type Carline, D-type Carline and the Bearing support. 

 As it has been decided in this project work to carryout the stress analysis of 

carline and bearing support and the material consumption minimization. There are 

many approaches for carrying out the stress analysis of the carline and bearing support. 

Experimental stress analysis by using strain gauges would have been a good approach. 

However, complicated shape of the carline would need very large number of strain 

gauges. Also the direction of the principal stresses being not known, one will have to 

use rosette analysis to make the work complete. S.G. analysis will require highly 

sophisticated equipment. 
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Because of the complicated shape of the carline, stress analysis by photo-

elasticity method will also be difficult. Stress analysis by finite element method is 

obviously the best choice. Hence finite element technique has been selected for the 

analysis purpose. 

With the availability of the commercial FE analysis software coupled to the 

solid modeler, it has been observed that finite element method is more convenient 

method for the component having complicated shape like carline. 

  Now as far as the material consumption minimization work is concerned, a vast 

number of different industries are regularly faced with the problem of cutting two-

dimensional objects from a stock-sheet as the first stage of their manufacturing process. 

The problem of forming a cutting plan by laying out the pieces onto the stock-sheet has 

traditionally been solved manually by an expert. Human intelligence is well able to 

tackle such problems and many studies comparing layouts obtained using automatic 

processes with those produced by an in-house expert show the computer generated 

solutions to be inferior in terms of trim-loss. However there is still considerable interest 

in generating automatic computerized solutions. In some industries the expertise 

required to beat the best packages often takes several years to acquire and in others the 

time required to produce a manual solution may be many times that of the automatic 

process. 

I have been working on the two-dimensional nesting method, which (in short) is 

the method of packing arbitrary two-dimensional shapes within the boundaries of some 

container. The objective can vary e.g. minimizing the size of a rectangular container or 

maximizing the number of shapes in the container, but the core problem which is 



addressed is to pack the shapes tightly without any overlap. An example of a tight 

packing is shown in Figure 1.1. 

 

Figure 1.1:  A tight packing using 86.5 % of the available area. 

A substantial amount of literature has been written about this problem, where most of it 

has been written within the past decade. A survey of the existing literature is given in 

Chapter 2. 

 

1.1   Introduction to problem:- 

The carline parts are a very important component of the railway coach roof. As 

such the design of the carline becomes very important in order to minimize the weight 

and hence the cost. So it is desired to carryout the stress analysis of carline. 

As stated above it has been decided to carryout the stress analysis of the carline 

and bearing support manufactured by rail coach factory, Kapurthala, using finite 

element technique.  
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The Figure 1.2 shows the two types of carline and bearing support for the 

analysis. 

         

C-type carline     D-type carline 

 

 Bearing support 

Figure 1.2: Models of two types of carline and bearing support 

The carline is manufactured by cutting the part out of the rectangular sheet of 

Corten steel material of 3500 x 1250 x 3 mm dimensions. The carline is welded on to 

the roof and the side walls of the coach. The loading on the C-type carline is mainly 

due to the electrical wiring passing through its slots and holes. In case of D-type 

carline, additional load of the AC ducting is applied on it. The bearing support is used 

in the door of the coach and it is used to cover the internal structure of the door. Hence 

the stress analysis has been carried out considering these loads only. As there are thirty 

four C-type carlines in a single coach, the load of the total electrical wiring is divided 

 4 
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equally between them. Also the load due to the AC ducting is equally divided between 

the eight D-type carlines. 

Based on the results of the Finite Element Analysis, it has been concluded that 

the material and the thickness of the carline parts is sufficient according the loading 

conditions.  

 After the FE analysis, material consumption minimization has been done using 

two-dimensional nesting. The term nesting has been used to describe a wide variety of 

two-dimensional cutting and packing problems. They all involve a non-overlapping 

placement of a set of irregular two- dimensional shapes within some region of two-

dimensional space, but the objective can vary. 

Most problems can be categorized as follows (also see the illustration in Figure 1.3): 

• Decision problem. Decide whether a set of shapes fit within a given region. 

• Knapsack problem. Given a set of shapes and a region, find a placement of a 

subset of shapes that maximizes the utilization (area covered) of the region. 

• Bin packing problem. Given a set of shapes and a set of regions, minimize the 

number of regions needed to place all shapes. 

• Strip packing problem. Given a set of shapes and a width W, minimize the 

length of a rectangular region with width W such that all shapes are contained in 

the region. 

 
As noted the region used for strip packing is rectangular and a typical example 

would be a cloth-strip in the textile industry. All other regions can have any shape. It 

could be animal hides in the leather industry, rectangular plates in the metal industry or 

tree boards in the furniture industry. 

 



 

Figure 1.3: a)  Most variants of the nesting problem is the problem of packing shapes 
within some region(s) without overlap (decision, knapsack and bin packing).  b)  The 
strip packing variant asks for a minimization of the length of a rectangular region. 
 
 
In industrial settings a multitude of additional constraints are very often necessary, e.g. 

the shapes or regions can have different quality zones or even holes (animal hides). 

Historically, the clothing industry has had special attention. But even though this 

industry introduces a multitude of possible extra constraints to the problem, these 

constraints are often not included in the published solution methods. An exception is 

Lengauer et al. [1] who describe and handle a long range of the possible additional 

constraints posed in the leather and the textile industry. But most of the existing 

literature does not handle any additional constraints.  

As indicated above the nesting problem occurs in a number of industries and it seems to 

have gotten just as many names. In the clothing industry it is usually called marker 

making, while the metal industry prefers to call it blank nesting or simply nesting. 

There is no consensus in the existing literature either. Some call the shapes irregular, 

others call them non-convex. In a theoretical context the problem is most often called 

the two-dimensional irregular cutting stock problem.  
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CHAPTER II 

LITERATURE REVIEW 
 

Applied mathematician Richard von Mises came up with the von Mises 

Criterion in 1913. Also known as the maximum distortion energy criterion, octahedral 

shear stress theory, or Maxwell-Huber-Hencky-von Mises theory, it is often used to 

estimate the yield of ductile materials. 

Von Mises stress, , is used to estimate yield criteria for ductile materials. It 

is calculated by combining stresses in two or three dimensions, with the result 

compared to the tensile strength of the material loaded in one dimension. Von Mises 

stress is also useful for calculating the fatigue strength. 

Stress is in general a six-dimensional tensor quantity (a symmetric 3×3 tensor). Von 

Mises stress reduces this to a single number (a scalar) for the purposes of calculating 

yield criteria. 

Von Mises stress in three dimensions is 

 

where 

σ ,σ ,σ1 2 3  

are the principal stresses. In the case of plane stress, σ3 is zero. 

Finite element analysis results are typically presented as Von Mises stress. 
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Figure 2.1: Von Mises ellipse 

The Von Mises criterion states that failure occurs when the energy of distortion 

reaches the same energy for yield/failure in uniaxial tension. Mathematically, this is 

expressed as, 

 
 

In the cases of plane stress, σ3 = 0. The Von Mises criterion reduces to, 

 
 

Also shown in the Figure 2.1, is the maximum shear stress (Tresca) criterion 

(dashed line). This theory is more conservative than the Von Mises criterion since it lies 

inside the Von Mises ellipse. 

In addition to bounding the principal stresses to prevent ductile failure, the Von 

Mises criterion also gives a reasonable estimation of fatigue failure, especially in cases 

of repeated tensile and tensile-shear loading. Therefore, for the analysis of carline, I 

have calculated Von Mises stresses. 
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Since the 1950s the nesting problem has received considerable attention because 

of the extensive use of computers, which have provided fast and economical 

computation, number crunching power, and the development of optimization 

techniques. A method of solving a version of the two-dimensional cutting-stock 

problem was given by Adamowicz and Albano [4]. In their version of the problem one 

was given a number of rectangular sheets and an order for a specified number of each 

of certain types of rectangular shapes. They observed that when an experienced person 

approached the problem of laying out rectangles on a rectangular sheet, he usually tried 

to lay the rectangles out in groups. In order to simplify the problem and speed up the 

solution he often attempts to lay out sets of shapes having at least one common 

dimension, so as to form large rectangular strips and blocks. Moreover he would 

backtrack: he would remove some part of the current layout and reposition the shapes. 

Although such an approach seldom provided an optimum solution, the solutions were 

usually extremely good. 

The approach is centered on an iterative procedure that first decided whether to 

fill a sheet or a rectangular subpart of it. Then it generated candidate groupings of 

rectangles called strips and select a subset of them to layout on the sheet part currently 

under examination. If that general layout was not acceptable, a different subdivision of 

the sheet was decided. Otherwise the algorithm determines a new subset to fill and the 

procedure was repeated as long as there were pieces to allocate. When the algorithm 

terminates, it did not in general yield the true minimum waste solution. However the 

complete process was quite efficient in terms of computer time.  

Extending their work further Adamowicz and Albano [5] published another paper 

on nesting two-dimensional shapes in rectangular modules describing an algorithm for 
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clustering irregular pieces in rectangular modules. Each piece was marked by a 

processing option. The set of options available to the user permits him to determine the 

types of clustering produced and to control the amount of processing time required per 

shape type.  The principal task of the algorithm was to accept an order for a specified 

number of various types of shapes (which may include irregular as well as rectangular 

shapes) and to produce a list of rectangular modules. These modules will, in general, be 

obtained from: 

1. Rectangular shapes 

2. Rectangular enclosures for irregular shapes 

3. Rectangular enclosures for pairs of irregular shapes 

4. Rectangular enclosures for various clustering are of irregular and rectangular 

shapes. 

The algorithm assumed that each shape is either a rectangle or a polygon. A 

rectangle is described by giving its length and width. The reference point of a rectangle 

is originally assumed to be its lower left-hand corner. A polygon is described by 

providing a list of the points (vertices) of the polygon given in a counter-clockwise 

(CCW) direction. The co-ordinates of each point of the polygon are given relative to the 

polygon reference point, which may or may not lie on the point on the original polygon. 

Using these representational schemes one could completely describe the placing of a 

shape (rectangle or polygon) by specifying the position of the reference point and the 

orientation (CCW) of the shape about the reference point.  

An alternative method for completely describing the placing of a shape, often useful 

at various stages of the processing of polygons, involves translating and rotating each 

point of the polygon. Suppose that one wish to rotate a given polygon by θ degrees 
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CCW about the reference point (x0, y0) and then translate it by (∆x, ∆y). Then for each 

point (xi, yi) one can compute the corresponding point      (x'i ,y'i) of the repositioned 

polygon as follows: 

x’i = xi  cos θ - yi  sin θ + ∆x 

y’i = xi  sin θ - yi  cos θ + ∆y 

The position of the reference point remains the same. 

A paper by Sanders and Bronsoiler [6] can also be classified as a heuristic 

search approach. They appeared to be the first authors who developed method for 

objective testing of irregular parts nesting algorithms. With a fractional factorial design 

and a specially designed random generator for irregular parts, they tested sensitivity of 

their algorithm to several variables, such as part sizes, part shapes and number of parts 

in the BOM. Their algorithm accepts a variety of irregular shapes and when adding 

another part to the existing nest, the algorithm tries the various possible orientations of 

the part (by rotating the part) in various possible locations along the upper and right 

sides of the existing nest. The price they paid for the flexibility is a requirement of 

considerable computing time. For a BOM with five types of parts, the time required per 

sheet was around 3 minutes on a small desktop microcomputer. For situations where 

BOM is relatively large, or where inventory or sheet sequence selection problems are 

under study, a faster heuristic method is required. 

  Qu and Sanders [7] developed an algorithm that considered the entire bill-of-

materials at one time and laid out several sheets at the same time. They also introduced 

an automatic algorithm for nesting of irregular-shaped parts, whose geometries are 

approximated by a composite of non-overlapping rectangles. They performed a test 

using a randomly generated bill-of-materials and showed that the algorithm is efficient, 



in terms of computation time and material usage. The time required for nesting each 

sheet was linearly related to number of unique parts and the number of parts laid on that 

sheet. The maximum length of time for laying one sheet was about 25 seconds. But, the 

major limitations of their algorithm are the approximation of blank geometry by non-

overlapping rectangles and the assumption that good layout patterns will not be non-

orthogonal.  

Another approach researched over the past decade is the No Fit Polygon NFP 

approach. In nesting problems the combinatorial problem coexists with a geometric 

problem, since solutions must be “geometrically” feasible: pieces may not overlap and 

must completely fit inside the plate. The concept of nofit polygon was used by Albano 

[8].  

The nofit polygon of piece B relative to piece A (NFPAB) is the locus of points 

traced by the reference point of B, when it slides along the contour of A. The relative 

orientations of A and B are maintained during this orbital movement. Piece B (the 

orbital piece) must never intersect piece A (the stationary piece) and they must be 

always in contact (see Figure 2.2). 

 

 

Figure 2.2: The no fit polygon of piece B relative to piece A. 

From this definition it immediately follows that: 
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• If the reference point of piece B is placed in the interior of NFPAB then B 

intersects A. 

• If the reference point of piece B is placed on the boundary of NFPAB then B 

touches A. 

• If the reference point of piece B is placed in the exterior of NFPAB then B does 

not intersects or touch A. 

To achieve a feasible (non-overlapping) and tight layout, each piece should have its 

reference point in the boundary of at least one nofit polygon relative to another piece 

and in the exterior of the nofit polygons relative to all the other pieces. The 

combinatorial problem arises when choosing a placement point for each piece, among 

its set of feasible placement points, knowing that the choice made will restrict the 

feasible set of placement points of all the other pieces. 

Another approach researched by Jeffrey W. Herrmann and David R. Delalio [9] is 

based on Dynamic Nesting. The manufacturer uses a manufacturing planning and 

control system that maintains a master production schedule. The planning system uses 

material requirements planning (MRP) to explode the end-item requirements into work 

orders for components and subassemblies. Also, the planning system has detailed 

routings (process plans) that specify the resources required for each product. Thus, 

production planners can identify, for next week and each week after that, the orders that 

will require the punch presses in the sheet metal area. (In this setting there are no filler 

parts available for consuming remaining open areas.)  

Because the product mix changes greatly each week, the sheet metal area will 

use dynamic nesting to nest the orders. Dynamic nesting periodically considers the 

specific orders to be punched in the next period and creates customized nests for those 



orders. That is, before each week, the production planners will identify and nest the 

orders that will be released into the shop that week. Orders that require the same NC 

punch press, the same material type, and the same sheet thickness can form a nest. 

Then, the production planners will use existing software that arranges the required parts 

on the minimum number of unsheared sheets, leaving room for the clamping area and 

leaving room between the parts. This software also creates the required NC program by 

combining the NC programs for each different part. After the orders are released, the 

operator loads this NC program onto the punch press and starts punching the nest, 

loading unsheared sheets and removing punched sheets as required. Punched sheets are 

sent to a deburring operation, where an employee removes the individual parts from the 

sheet, removes any burrs from the part, and sorts the parts into the individual work 

orders for additional processing. For a simple example, consider Figure 2.3  

 

Figure 2.3: Three orders and two possible nests. 

Order 1 requires two parts, one on each sheared sheet. Order 2 requires four 

parts, all on one sheared sheet. Order 3 requires four parts, two on each sheared sheet. 

All three orders require the same material type and thickness. Thus, they can form a 

nest. Nesting all three orders creates the nest in the bottom right of the figure. The nest 
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requires two unsheared sheets. If the nest includes only Orders 1 and 2, then the nest 

requires only one unsheared sheet, as shown in the bottom left of the figure. Order 3 is 

processed separately.  
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CHAPTER III 

FE ANALYSIS OF CARLINE 
 
 
3.1   Overview of FEM:-

The finite element method is a numerical technique, well suited to digital 

computers, which can be applied to solve problems in solid mechanics, fluid 

mechanics, heat transfer and vibrations. The procedures to solve problems in each of 

these fields are similar; however this discussion will address the application of finite 

element methods to solid mechanics problems. In all finite element models the domain 

(the solid in solid mechanics problems) is divided into a finite number of elements. 

These elements are connected at points called nodes. In solids models, displacements in 

each element are directly related to the nodal displacements. The nodal displacements 

are then related to the strains and the stresses in the elements. The finite element 

method tries to choose the nodal displacements so that the stresses are in equilibrium 

(approximately) with the applied loads. The nodal displacements must also be 

consistent with any constraints on the motion of the structure.  

The finite element method converts the conditions of equilibrium into a set of 

linear algebraic equations for the nodal displacements. Once the equations are solved, 

one can find the actual strains and stresses in all the elements. By breaking the structure 

into a larger number of smaller elements, the stresses become closer to achieving 

equilibrium with the applied loads. Therefore an important concept in the use of finite 

element methods is that, in general, a finite element model approaches the true solution 

to the problem only as the element density is increased. 
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3.2 Basic steps in FEM :- 

Stress analysis using finite element method has become highly popular, economical 

and versatile method. Many design engineers are familiar with finite element method; 

however the basic steps in FEM for stress analysis are described in short as follows. 

1. Discretization of the continuum :- 

 The Discretization is simply to sub-divide given body into an equivalent system 

of finite elements. The finite elements may be triangles, quadrilaterals, tetrahedrons 

etc. depending upon the type of analysis. 

2. Selection of the displacement models :- 

 The assumed displacement functions or models represent only approximately 

the actual distribution of the displacements. A displacement function is commonly 

assumed in polynomial form. 

3. Derivation of the element stiffness matrix :- 

 The stiffness matrix consists of the coefficients of the equilibrium equations 

derived from the material and the geometric properties of the element. The 

equilibrium relation between the stiffness matrix [k], nodal force vector {Q} and the 

nodal displacement vector {q} is expressed as below. 

  [k]e {q}e = {Q}  

4. Assembly of the algebraic equations for the overall discretized continuum :- 

 The process includes the assembly of the overall stiffness matrix for the entire 

body from the individual element stiffness matrices and the overall force vector 

from the element nodal force vectors. The overall equilibrium relations between the 

total stiffness matrix [k], total load vector {R} and the nodal displacement vector 

{r} will be as below.  
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  [k] {r} = {R}  

These sets of equations can be solved by making use of boundary conditions. 

5. Solution for unknown displacements :- 

 The algebraic equations assembled in step 4 are solved for unknown 

displacements by using matrix algebra techniques. 

6. Computation of the element strains and stresses :- 

 More often, stresses/strains are computed from the nodal displacements 

calculated in step 5. Usually the stresses are calculated at the center of the element.  

In the present work FE analysis of the carline and bearing support has been 

carried out using ANSYS 9.0 package. 

3.3   About ANSYS Multiphysics 9.0 package

 ANSYS is a general purpose finite element modeling package for numerically 

solving a wide variety of mechanical problems. These problems include: static/dynamic 

structural analysis (both linear and non-linear), heat transfer and fluid problems, as well 

as acoustic and electro-magnetic problems. 

1. Preprocessing: defining the problem; the major steps in preprocessing are 
given below:  

• Define Key points/lines/areas/volumes  

• Define element type and material/geometric properties  

• Mesh lines/areas/volumes as required  

The amount of detail required will depend on the dimensionality of the analysis 

(i.e. 1D, 2D, axi-symmetric, 3D).  

2. Solution: assigning loads, constraints and solving; 
Here we specify the loads (point or pressure), constraints (translational and 

rotational) and finally solve the resulting set of equations.  
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3. Post processing: further processing and viewing of the results; in this stage 
one may wish to see:  

• Lists of nodal displacements  

• Element forces and moments  

• Deflection plots  

• Stress contour diagrams  

3.4   Features of ANSYS 9.0

• Analysis of one dimensional , two dimensional and three dimensional 

finite element models 

• Linear and nonlinear analysis 

• Static & Dynamic analysis 

• Heat Transfer Analysis 

• Multi Point Constraints facility 

• Elastic, Creep Material Models 

• Buckling Analysis 

• Big Element Library 

• Preprocessing facility 

• Post-processing facility 

3.5   Analysis:- 

 Following are the different stages of FE analysis discussed in detail using the 

ANSYS 9.0 software. 

3.5.1   Pre-Processing:- 

 This stage involves preparation of the geometric model using Pro Engineer 

(Wild-fire 2.0) solid modeler. The model is discritized selecting the suitable finite 

element boundary conditions like fixity etc. as well as material properties are also given 

at this stage. 

 



3.5.1.1.   Geometric Modeling:- 

 Geometric modeling is the process of generating three-dimensional objects of 

the real world for the purpose of analysis, design, drafting and manufacturing etc. 

Geometry of the part can be created in several different ways. These include starting 

from primitives. A key philosophy in geometric modeling is to sketch sections on work 

plane or on a face of an object and modify the dimensions later. Geometric modeling 

creates a data base in the computer, which represents the object generated. This object 

database is used to display the object, to prepare drawings of the object with different 

views, to prepare data for analysis and design and also to manufacture the object using 

CNC machines. There are three types of geometric models commonly used to represent 

physical objects. They are as follows: 

• Wire-Frame Modeling 
 
• Surface Modeling 
 
• Solid Modeling 

 
a) Wire-Frame Modeling 
 
 Figure 3.1 shows an example of wire frame model. As seen from the figure it 

consists of finite set of points, lines or polygons in space. Point, line and polygon are 

basic elements of the wire frame modeling. In wire frame model, the equations of the 

boundary curves of the object are stored. Wire frame models are used to create models 

of simple objects.  

 

Figure 3.1: Wire-frame Model 
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Many CAD systems provide wire frame Modeling where a sequence of commands 

generate wire frame models of three dimensional objects, first generating points and 

lines and then applying Modeling transformation like translation, rotation and scaling. 

In the construction of wire frame model, the edges of the object are shown as lines. For 

object in which there are curved surfaces, contour lines can be added to indicate 

contour. The image assumes the appearance of frame construction out of wire – hence 

the name “Wire-Frame” model. 

Wire-frame models are easy to create and use. In many cases they are quite adequate 

for two-dimensional representation. 

Limitations: 

• There are limitations to the models, which use the wire-frame approach to form 

the image, especially in the case of three-dimensional models. All of the lines 

that define the edges of the model are shown in the image. Consequently, the 

lines that indicate edges at the rear of the model are also shown. This can cause 

the image to be somewhat confusing to the viewer. 

• With a just wire frame representation, it is impossible to check for three-

dimensional interference, since there is no representation for the surface 

between wires. 

• As it does not distinguish between inside and outside of the surface of the object 

they are inadequate to be used for generating cutting path to drive NC machine 

to manufacture the objects. 

Applications/ Uses: 

• Enhancing visualization of 3D objects. 

• Automatically generating standard and auxiliary views. 



• Generating a wire frame on which to create surfaces. 

• Visual interference checking. 

• Reducing the need to create prototypes. 

• Approximating volume & mass. 

• Perspective viewing. 

b) Surface modeling 
 
 Figure 3.2 shows an example of surface modeling. In surface modeling, surface 

entities are introduced to the wire frame model. Surface models define part geometry 

more precisely, as compared to the wire frame model. A surface model stores equations 

representing each of the surfaces of an object as well as the edge boundaries. Many 

methods are available to generate the surfaces. Objects with complex shapes are 

generated by combining planes, ruled surfaces of revolutions, sweep surfaces and fillet 

surfaces. 

 

Figure 3.2: Surface model 

An object generated through surface modeling can be displaced on a screen, in 

such a way that it look like a solid object. Techniques like hidden surface removal and 

hidden line removal makes to display the objects as a solid object and can be viewed 

from any point. 
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Limitations: 

• In surface model, it may still be difficult to check for interference, since we 

might not know for sure which is the inside or the outside of each surface. For 

the same reason, it will be difficult to compute mass inertial of such an object, 

especially if the surface model is not completely closed. 

• As these models also do not truly represent the solid nature of the object, a still 

higher level of sophistication is required in geometric modeling, which makes it 

possible to represent the information on the solid nature of the object, which is 

necessary to carry out engineering analysis of the object. 

 
Applications: 

Surface modeling is applicable for analysis of aircraft and automobile surfaces. 

A fancy animated 3D graphics generated for television “flying logos” only need surface 

modeling, since mass properties and other mechanical applications are not a concern. 

c) Solid Modeling 
 

The example of solid model is as shown in the Figure 3.3. It contains enough 

information to fully describe the boundaries, surfaces and topology of the object. If we 

cut a solid object, the result is another solid object, not an ambiguous collection of 

partial lines or surfaces. Solid model is represented by volume. With this, interference 

volumes can easily be computed, and the properties of area, volume and mass can be 

calculated. The object can be displayed as hidden line removed or as shaded image to 

show clearly how the parts look like in three dimensions. 



 

Figure 3.3:    Solid model 

Since solid modeling is complete representation, it can be used to support any type of 

design and analysis application that requires geometry information. These applications 

may include drafting, finite element analysis, packaging studies, kinematics, visual 

displays and manufacturing. 

There are two methods used to construct solid models. 

1.   Constructive solid geometry (CSG): 

 This method uses basic shapes like cube, prism, cylinder, sphere etc. as 

primitives to build the model of complex objects. In this approach primitives are 

combined to generate complex objects by Boolean operations such as union, 

intersection, difference etc. The primitives are first positioned in the proper place and 

the Boolean operations are carried out. 

 CSG modeling is more useful to generate the shapes whose surfaces are more 

standard. The CSG method is slower, but has the advantage of greater accuracy and 

flexibility of making changes to the object. 

2.   Boundary Representation (BREP): 

 Boundary representation provides an efficient solution where the model has 

complex surfaces. In this approach, the perimeter on the boundary of the model is used 

to represent the solid objects. In this modeling both topology and geometry of solid 

models are defined and stored in database. The solid is first assumed to be made up of 
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surfaces, then the surfaces are formed by combining edges and finely the edges are 

formed by combining vertices. This representation contains all the necessary 

information regarding geometry of solid. The boundary representation is more suitable 

for generating different views of the solid model as well as for computing geometric 

and inertial properties. 

 Most commercial solid modeling programs are based on either Boundary 

Representation (BREP) or Constructive Solid Geometry (CSG). BREP modelers store 

results of operations (i.e. what exists after creation and manipulations), and CSG 

modelers store a history of the objects and operations required to construct the part. 

This geometric model is used for FE analysis. 

3.5.1.2     Properties of Corten steel 

Corten steel is a steel alloy that has a very high tensile strength. It is about twice 

as strong as sheet metal of comparable thickness. Hardness and tensile strength are 

important properties, but Corten’s main advantage is its resistance to corrosion. Corten 

will not rust; rather it will oxidize slowly to a dull grey-brown color. Over time it may 

appear almost purple.  

The chief application of Corten is in outdoor sculptures, marine vessel 

fabrication and as exterior facades for its rustic antique appearance. All the areas where 

rust and corrosion resistance is of extreme importance.  Corten steel is also popularly 

used in bridge and other large structural applications. In some geography it may be 

known with the hyphen as "Cor-ten steel". This is the material which is used to make 

the railway coaches in Rail Coach Factory, Kapurthala. 
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Mechanical properties of Corten steel 

 It is essential to know physical and mechanical properties of the material. These 

are given below. 

Table 3.1: Physical and mechanical properties of Corten steel 

S.No. Properties Values 

1. Density (1000 kg/m3) 7.85 

2. Elastic Modulus (GPa) 190 

3. Poisson’s Ratio  0.3 

4. Tensile Strength (MPa) 956 

5. Yield Strength (MPa) 648 

6. Hardness (Brinell 3000 kg) 150 

 

3.5.1.3   Meshing:- 

 The meshing operation is a two step process. First the parameters defining the 

size and type of elements and other attributes are defined on the particular edges, 

surfaces or volumes of the part. The second step is to generate the mesh on this 

geometry.  

 Three-dimensional solid element tetrahedron type having a length of .75 mm for 

all side is selected, considering nature and shape of the carline. Figure 3.4 shows a ten 

node tetrahedral element having three degree of freedom at each node, i.e. translation in 

the nodal x, y & z directions. The element has large deflection and large strain 

capabilities. This element is used, since the use of this tetrahedron results in realistic 

geometry. 



 

Figure 3.4: 10 Node Tetrahedral Element 

 The complete part is meshed by automatic free meshing option in meshing task 

of the ANSYS software. Figure 3.5 shows the meshing of the carlines. 

 

Figure 3.5a:   Meshing of C-type Carline 
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Figure 3.5b:   Meshing of D-type Carline 

Several checks are applied while giving the model for meshing. These are as follows. 

• Element free edge check will plot the free edges of element not connected to 

another element. 

• Check for duplicate nodes. 

• Check for duplicate or missing elements. 

• Check for distorted or warped element (Value given >04) 

• Check for warping out of plane, interior angles, mid side node placements and 

coincident elements. 

 

 

 

 28 



In first iteration the following data is obtained – 

Table 3.2: Details of Meshing 

S.No. Name of Part Total number of 

tetrahedron 

Total number of 

nodes 

1. C-type Carline 19756 41096 

2. D-type Carline 20010 41889 

 

3.5.1.4   Displacement Condition:- 

The carlines are welded on to the roof at the top surface and at the two bottom 

end surfaces.  So the X, Y, Z translations at those nodes is zero. 

 

Figure 3.6a: Displacement condition of C-type Carline 
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Figure 3.6b: Displacement condition of D-type Carline 
 

3.5.1.5   Force Condition:- 

The loads applied on the different parts are as per the loading conditions specified in 

the design. In the C-type carline the loads are applied as follows.  

Table 3.3: Loading values 

Name of Part Closed Slots 

in Newton 

Open slot 

in Newton 

Circular Hole 

in Newton 

AC duct slot 

in Newton 

C-type Carline 12.2625 7.3575 5.350 NA 

D-type Carline 12.2625 7.3575 5.350 24.525 
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 The above loads are applied on the carline. ANSYS has the facility to apply 

boundary condition to carline itself; software transmits this load to the elements 

appropriately. 

3.5.2   Processing:- 

 In this phase of the analysis, the computer takes data and solves the 

simultaneous equations that the finite element method generates. The results of the 

solution are displacement and stress values at the nodal point. With the finite element 

model created as described above, static analysis was performed using ANSYS 

software.  

In processing, the Iterative Solver is used. This solver starts with element matrix 

formulation and assembles full global matrix. The solver then gives solution for each 

degree of freedom by iterating to convergence. 

 

3.5.3   Post-Processing:- 

 Post-processing involves reviewing the results of the FE analysis by way of 

color contours, tables, graphs, charts etc. and comparing these results with failure 

criteria imposed on the design such as maximum deflection allowed, the static and 

fatigue stress limit for materials etc. 

 It is probably most important step in the analysis. ANSYS software is used to 

display the results. 

 

 

 

 



 

 

The results of FE analysis are as follows-  

1. Displacement contour occurred after loading is shown in Figure 3.7.  

 

Figure 3.7a: Displacement plot of C-type Carline 
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Figure 3.7b: Displacement plot of D-type Carline 

It is seen that the maximum deformation in the parts is negligible and are as 

follows. 

Table 3.4: Maximum deformation details 

S.No. Name of part Maximum Deformation 

(m) 

1. C-type Carline 0.125E-06 

2. D-type Carline 0.358E-06 
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2. Stress contour plots are shown in figures 3.8. The magenta and yellow colors 

show maximum and minimum stresses in the parts. 

 

 Figure 3.8a: Von mises stress in C-type Carline 

 

 Figure 3.8b: Von mises stress in D-type Carline 
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The maximum stresses occur only at few locations and is tabulated below. 

Table 3.5: Maximum stresses details 

S.No. Name of part Maximum Stress 

(in Mpa) 

1. C-type Carline 199.497 

2. D-type Carline 570.264 

  

3.6   Conclusion:-

 The following conclusion may be drawn from the finite element analysis carried 

out during study of the parts. 

1. Maximum deformation in C-type carline is 0.125E-06, for D-type carline is 

0.358E-06 which is quite negligible. 

2. Maximum Von Mises stress in C-type carline is 199.497 MPa and in D-type 

carline it is 570.264 MPa. The most of the area of the parts is well below the 

allowable stress of the material which shows that the thickness is sufficient 

for the purpose. 
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CHAPTER IV 

MATERIAL CONSUMPTION MINIMIZATION USING 
MOST 2D 

 
 
4.1   Introduction:-

MOST 2D is nesting software for generating layouts for profile cutting 

applications. MOST 2D is primarily used for reducing scrap in sheet metal cutting as 

well as heavy fabrication. The software can also generate CNC codes for all the popular 

oxyfuel, plasma, laser and water jet cutting machines. 

ITEM, the cad module accompanying this software allows you to generate 

simple 2-D shape drawings and supports a batch mode converter for reading dxf / dwg / 

g-code files. Material Engineer is another module that allows you to define cutting 

properties (like kerf/ speed / leadin length) for various types of raw materials. For 

customized applications, the software may support additional modules / functions. 

4.2   Nesting method used by Most 2D:-

Nesting has great cost-saving potential since a nest requires only one setup and 

fewer standard sheets. However, finding the optimal nest (which minimizes the set-up 

and material costs) is not a simple problem. The production planners need a tool to help 

identify good nests. However, they must make this nesting decision before they can 

generate the actual nest layout (and the associated NC program). To overcome this 

obstacle, the layout problem was simplified by considering only the area that each part 

requires and the total usable area of a sheet. A part’s required area, which may have a 

complex profile, includes the necessary interpart spacing and any internal area that no 

other part could possibly use.  
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It is assumed that parts will fit onto a sheet if the total area is sufficient. If many 

of the parts were large, then this approximation would be poor, and then it would create 

the need to consider the part geometry and part layout explicitly in the nesting decision 

process. However, in practice, the parts were small compared to an unsheared sheet, so 

the approximation is acceptable. Note that the nesting decision determines which orders 

(and parts) the nest should include, but it does not create a layout for the parts on the 

sheets. If the actual part layout for the nest did require more unsheared sheets than the 

nesting decision predicted, there would be time to modify the nesting decision. Thus, 

the area approximation for making the nesting decision. 

Dynamic nesting reduces set-ups and material requirements. However, finding 

the most cost-effective nest is a problem. The nesting decision for a group of orders is 

based on the point that the parts should have same material type and thickness. The 

objective is to minimize the total cost of setup and material. When beginning to 

implement dynamic nesting, nesting all orders may seem like a good strategy. 

Unfortunately, it could lead to poor solutions. It is assumed that parts will fit onto a 

sheet if the total area is sufficient.  

4.3   Steps performed:- 
 

In the Rail Coach factory, Kapurthala, many different types of coaches are made 

requiring different variety of parts. The nesting procedures combines multiple orders 

that require the same type of sheet metal so that the CNC machine can complete all of 

the parts in these orders as one job. The important point in the start is that we have to 

identify the parts which we want to nest as they should be of the same material and the 

same thickness. Therefore after thorough observation it was decided to nest C-type, D-
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type carline and bearing support as these parts fall under the same group set. Groups set 

of Corten steel material and thickness 3 mm. 

The step by step procedure of using the software efficiently and getting the 

desired results is given below. 

4.3.1   CAD - Make the 2D part drawing:- 
 

1. For creating a new item drawing, start ITEM – CAD. 

2. Create the item drawing using commands under the sketch menu in ITEM - 

CAD and proceed to the next step. 

3. Select the command View => Zoom out to see the complete item drawing. (Shift 

+ O) 

4. Select the command Tools => Validate to check the item drawing. 

5. Select the command File => Save to save the drawing in an MDF file. (Control 

+ S) 

4.3.2   Nesting – Make nested layouts:- 
 
 

1. Specify all the default options / settings, after installing the software. (This is a 

one time activity.) 

2. Define a new input job for nesting. 

3. Start MOST 2D. 

4. Select the command File => New to start a new job in MOST. (Control + N) 

5. Select OK button in the new job dialog box. 

6. Define constraints i.e. cutting parameters for the job. (This step is not required if 

you use material database.) 

7. Select the command Job => Constraints. (F-10) 
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8. Specify tool size (kerf) as well as clearance limit (additional distance between 

parts, after leaving 2*kerf distance) in the constraints dialog box. Select OK 

button in the dialog box. 

9. Select the command Job => Export => Full Job in order to save the input job in 

a foundation file. (Control+F) 

10. Define the stock list i.e. the inventory of fresh and off cut stocks, which are 

available for nesting. 

11. Select the command Job => Stock list. (F-11) 

12. If you want to add a fresh rectangular stock to the stock list, execute the 

following steps. 

13. Select Add Fresh Stock button in the stock list dialog box. Type the stock 

dimensions and select OK button in the dialog box that appears on the screen.  

Type stock name (say, "fresh stock 1") and select OK button in the dialog box 

that appears on the screen. 

14. Specify stock properties using the options shown in stock properties dialog box. 

 
 (In particular,  
Specify total number of stocks available using General => Total quantity,  
Stock material using Physical => Material 

      and stock thickness using Physical => Thickness options.)  
 

15. Select OK button in the dialog box. 

16. Select the command Job => Export => Full Job in order to save the input job in 

a foundation file. (Control+F) 

17. Define the shape list i.e. bill of materials, containing the list of all the parts 

which have to be nested. 

18. Select the command Job => Shape list. (F-12)  
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19. If you want to add a new shape for nesting, execute the following steps. 

20. Select Add Shape button in the shape list dialog box. 

21. Select the part drawing file (typically, an MDF file generated using steps 1 to 5 

described earlier in CAD steps) from the file selection dialog box and select the 

OK button. Note, you can also select multiple part drawing files by keeping the 

Control key pressed, while selecting the part drawing files from the dialog box. 

22. Type shape name and select OK button in the new dialog box that appears on 

the screen. 

23. Specify shape properties using the options shown in shape properties dialog box. 

 (In particular,  
specify total number of shapes to be cut using General => Total quantity,  
shape material using Physical => Material 

      and shape thickness using Physical => Thickness options.) 
 

24.  Select OK button in the dialog box. 

25. If you want to change the properties of an existing shape, select the shape with 

the mouse and click on the properties button in the shape list dialog box. If you 

want to remove an existing shape from the shape list, select the shape with the 

mouse and click on the Remove button in the shape list dialog box. 

26. Select the Close button in the shape list dialog box, after making all the 

modifications in the shape list. 

27. Select the command Job => Export => Full Job in order to save the input job in 

a foundation file. (Control+F) 

28. Nest the job. 

29. Select the command Fit => Go to nest the job automatically. (F-5). So after 

entering all the details step by step in the MOST 2D software as discussed in 

Chapter 5, we generate the automatic nest. The results are displayed below.  



The nested layouts which the software makes are as follows: 

Layout 1: Nested 2 parts of D-type Carline and frequency is 4. 

 

Frequency 4 means that the same nest is made on 4 stocks of Corten steel 

sheet totaling the number of parts cut to 8 which is the requirement. 

Layout 2: Nested 8 parts of Bearing support 

 

In this layout 8 parts of Bearing support are nested and the frequency is 1. 
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Layout 3: Nested 3 parts of C-type Carline and frequency is 11. 

 

Here we can see that the nest of C-type Carline is of in a group of 3 pieces 

each on the stock sheet and the frequency is 11 which totals to 33 pieces of C-type 

Carline. 

Layout 4: Nested 1 remaining part of C-type Carline. 

 

Here we can see that the last remaining part of the C-type Carline is nested on 

a separate stock. 

30. Select the command File => Save to save the nested job in a job file, which is a 

binary file having the extension JOB. (Control +S) You can open this file for 

further editing in your next session with MOST, if required. 
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31. Study each nested layout using commands like zoom-in, zoom-out, pan, etc. 

under View menu. 

32. Modify the layouts manually using commands like move, slide, rotate, mirror, 

add, remove, etc. under Fit menu. 

Now the question was whether the given nest could be further improved to 

minimize material consumption. So to improve it further, shapes were added and 

moved in the nest and it was build again. 

 
33. Select the command Fit => Build, if you would like to nest the layout 

automatically, without removing those shapes which have been already nested 

on the stock.  

Layout 5: Nest of 2 units of C-type Carline, 1 unit of D-type Carline and 2 units 
of bearing support. 
 

 

Here we see that the on one stock sheet, we have nested 2 units of C-type 

Carline, 1 unit of D-type Carline and 2 units of Bearing support. The frequency of 

this layout is 4. So total, 8 units of C-type Carline, 4 units of D-type Carline and 8 

units of bearing support are nested. 
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Layout 6: Nest of 2 units of C-type Carline and 1 unit of D-type Carline. 

 

Now the requirement of bearing support is exhausted, so it was removed from 

the nest. Here in layout 2, we see that there are 2 units of C-type Carline and 1 

unit of D-type Carline. The frequency of this layout is 4, which means that total 8 

units of C-type Carline and 4 units of D-type Carline will be nested. After this the 

requirement of the D-type Carline is exhausted as all 8 parts have been nested. 

Layout 7:   Nest of 3 units of C-type Carline. 

  

Here we see that 3 units of C-type Carline are nested and the frequency is 6.  
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So total 18 units of C-type Carline are nested. Including all the 3 layouts 5, 6 

& 7, we get the desired nest. 

 
34. Select the command File => Save to save the modified nested job once again in 

the job file. (Control +S) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



CHAPTER V 

RESULTS, DISCUSSIONS & CONCLUSIONS 
 

 

Initially finite element analysis has been carried out to studying, analyzing and 

validating the designed model of the parts under consideration for various stresses 

developed due to the different loading conditions. After analysis of the 3-D models of 

the parts then material consumption minimization has been done to reduce the amount 

of raw material sheets used for cutting the parts out of rectangular stocks. 

5.1 Displacement plots of parts

 

Figure 5.1a: Displacement plot of C-type carline 
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Figure 5.1b: Displacement plot of D-type carline 

 

Table 5.1: Maximum deformation details 

S.No. Name of part Maximum Deformation 

(m) 

1. C-type Carline 0.125E-06 

2. D-type Carline 0.358E-06 

 

It is seen that the maximum displacement/deformation in all the parts analyzed 

as tabulated above is quite negligible.  
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5.2 Nodal Solution of stresses developed in parts

The nodal solution of the different types of stresses developed in the parts is 

tabulated below.  

 

Figure 5.2a: Von mises stresses in C-type carline 

Table 5.2a: Minimum von mises stresses in C-type carline (in MPa) 

 S1 S2 S3 INT SEQV 

NODE 1736 1509 16276 496 496 

VALUE -4.3697 -14.663 -107.75 0.25560E-03 0.22382E-03 

 

Table 5.2b: Maximum von mises stresses in C-type carline (in MPa) 

 S1 S2 S3 INT SEQV 

NODE 27230 13142 13142 16238 16238 

VALUE 196.94 40.402 31.424 203.36 199.36 

 
 48 



 

Figure 5.2b: Von mises stresses in D-type carline 

 

Table 5.3a: Minimum von mises stresses in D-type carline (in MPa) 

 S1 S2 S3 INT SEQV 

NODE 12060 1112 1110 14061 14061 

VALUE -12.467 -41.839 -306.94 0.28038E-03 0.24572E-03 

 

Table 5.3b: Maximum von mises stresses in D-type carline (in MPa) 

 S1 S2 S3 INT SEQV 

NODE 1694 24426 27425 1694 1694 

VALUE 562.79 106.26 81.825 581.25 569.87 
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It is seen that the maximum stress occurs only in a select elements. Rest of the 

elements in the parts are under very less stress. The maximum von mises stress 

developed is well below the allowable limits. 

Table 5.4: Properties of Corten 

S.No. Properties Values 

1. Tensile strength (MPa) 956 

2. Yield strength (MPa) 648 

 

Therefore we can safely say that the design of the parts is satisfactory.  

5.3 Material Consumption minimization results 

Coming to the material consumption minimization part of the project work, the 

following are the specifications of each part. 

Table 5.5: Specifications of each part 

Shape Name Dimensions Quantity 

(per coach) 

Area ( sq m ) 

( per  part ) 

Perimeter ( mm ) 

( per  part ) 

AE16361A 

(C-type carline) 

714.33 x 3200.83 34 0.28 9211.74 

AE16363A 

(D-type carline) 

714.33 x 3200.83 8 0.40 11940.84 

cc10858a 

(Bearing  support) 

391 x 1042.00 8 0.37 2844.54 

 

It is observed that the part AE16363A has the largest area of 0.40 sq m followed 

by cc10858a having area 0.37 sq m and then part AE16361A having area 0.28 sq m. 
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And as the working of MOST 2D is based on area wise priority used in dynamic 

nesting, whenever the nesting is done the software tries to fit the largest area part first 

in the stock and after it has exhausted the part, then it goes for the second largest area 

part and nests it. And like wise the procedure is followed in descending order of area 

until all the parts are nested. 

 The automatically generated nest as discussed in Chapter IV consisting of four 

nested layouts gives the results as below in Table 5.6 

Table 5.6: Details of results of automatic nesting 

Layout 

Number 

Stock 

Area 

 (sq m) 

Item Area

 (sq m) 

Scrap 

Area 

 (sq m) 

Consumed 

Area 

 (sq m) 

No. of 

Stocks 

Consumed

% 

Utilization

Layout 1 4.0624 0.8062 3.2563 4.0625 4 19.85 

Layout 2 4.0625 2.9706 1.0919 4.0625 1 73.12 

Layout 3 4.0625 0.8538 3.2087 4.0625 11 21.02 

Layout 4 4.0625 0.2846 3.7779 4.0625 1 7.01 

 

We observe that a total of 17 sheets of the stock raw material are consumed for 

the cutting the desired nest of pieces when that nest is generated automatically by the 

MOST 2D software. 

 Now the question was whether the consumption of the stock sheet could be 

minimized further. To reduce it, shapes were added and moved in the nest and it was 

build again which gave the following nested layouts for the same BOM. 
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Table 5.7: Details of results of built nest 

Layout 

Number 

Stock 

Area 

 (sq m) 

Item 

Area 

 (sq m) 

Scrap 

Area 

 (sq m) 

Consumed 

Area 

 (sq m) 

No. of 

Stocks 

Consumed

% 

Utilization 

Layout 5  4.0624 1.7150 2.3475 4.0625 4 42.21 

Layout 6 4.0625 0.9723 3.0902 4.0625 4 23.93 

Layout 7 4.0625 0.8538 3.2087 4.0625 6 21.02 

 
 
 
From the Table 5.7 it is clear that the built nest has given us better results as compared to 

the automatic nest. 

Table 5.8: Comparative analysis of Automatic vs. Built Nest 
 

Type of nesting scheme Point under 
Consideration Automatic Built 

Number of Parts 
nested 

C-type carline       34 
D-type carline       08 
Bearing support    08 

C-type carline       34 
D-type carline       08 
Bearing support    08 

Number of Stocks 
Consumed 17 14 

% Utilization 
(weighted avg.) 22.9582 27.9057 

 
 

The below mentioned results have been achieved by using the material consumption 

minimization method discussed in chapter 4. 

1. The consumption of rectangular stock sheets has come down by 3 units for every 

bill of material. Less number of layouts have to be made. 

2. The % utilization of the stock sheet area has gone up by 4.9475 %. 

3. It has been estimated that the CNC machine producing these parts has an 

operational cost of Rs. 1500/- per hour. This cost is inclusive of the wage paid to 
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the operator to operate the machine. The total setup time for setting up one 

rectangular stock sheet for cutting is 5 minutes.  So considering that we have 

reduced the consumption of material i.e. the rectangular stock sheets, by three 

units. That directly means that the net setup time saved is of fifteen minutes which 

in rupees is of Rs. 375/- for cutting the three parts for one coach. Also saving of 3 

stock sheets leads to saving of Rs. 13780/- as one sheets costs around Rs. 4593/-. 

 
The results which have been obtained using the nesting approach described in 

previous chapters indicate that the built nests keeping in view the results obtained in 

automatic nests turns out to be an effective tool in designing minimal waste layouts for 

problems that involve 1) a set of standard rectangular sheets, 2) order to produce a large 

number of various types of shapes which include irregular as well as rectangular-like 

shapes, 3) the requirements that no two shapes may overlap and that only the exact 

types and numbers of shapes ordered are to be produced, and 4) minimize waste. 

Although the layouts obtained by automatic nesting did not in general give the 

best possible % utilization of the stock sheet, still they can turn out to be fairly good in 

the case when complexity of the nest is very high, i.e. a large number of different shape 

parts have to nested. When the complexity is very high then manual nesting might be 

very time consuming process and may generate lots of errors as it is dependent on the 

skill and experience of the operator. 
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CHAPTER VI 

FUTURE SCOPE 
 

 

The FE analysis has been carried out for the stresses and deformations. The work 

can be extended to cover the dynamic analysis giving the natural frequency, mode shapes 

etc. This is very essential to avoid resonance. 

As we saw in the material consumption minimization, that even after applying the 

dynamic nesting method, we could not get the best results. This opens up a lot of scope 

for future research. In our approach there was no constraint of grain direction, but this 

can be very well important in the case of leather, garment industry etc. Also the 

generalization of the nesting technique has to be there so that it can be applied in different 

fields. 

The second scope of research in the future is in the improvement of the nesting 

algorithm. It should be able to deeply analyze the given constraints and be able to give 

desired results with minimum computation time.  

Lastly, the priority setting of different shapes was not covered in this project work 

as it was not required as all the parts were of same priority. But in case if some of the 

parts have high priority than the other parts then things might work out differently. That 

would be too complex a decision to be made by a human operator. So I think the nesting 

algorithms can be researched and improved in this direction as well.  
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APPENDIX - I 

 
1. CNC CODE FOR LAYOUT 5 
 
% 
N1G29X1235.0Y3222.3P1H1 
N2G51X0.0Y0.0O0 
N1001G0X-415.66Y1472.50 
N1002G1X-407.00Y1477.50M04 
N1003G1Y2519.50 
N1004G1X-270.00 
N1005G1Y2510.00 
N1006G1X-186.50 
N1007G1Y2442.50 
N1008G3X-161.50Y2417.50I-
161.50J2442.50 
N1009G1X-16.00 
N1010G1Y1579.50 
N1011G1X-161.50 
N1012G3X-186.50Y1554.50I-
161.50J1554.50 
N1013G1Y1487.00 
N1014G1X-270.00 
N1015G1Y1477.50 
N1016G1X-407.00M05 
N1017G0X-245.16Y448.50 
N1018G1X-236.50Y453.50M04 
N1019G1Y521.00 
N1020G3X-261.50Y546.00I-
261.50J521.00 
N1021G1X-407.00 
N1022G1Y1384.00 
N1023G1X-261.50 
N1024G3X-236.50Y1409.00I-
261.50J1409.00 
N1025G1Y1476.50 
N1026G1X-153.00 
N1027G1Y1486.00 
N1028G1X-16.00 
N1029G1Y444.00 
N1030G1X-153.00 
N1031G1Y453.50 
N1032G1X-236.50M05 
N1033G0X-350.74Y242.51 
N1034G1X-355.62Y233.78M04 

N1035G3X-303.17Y163.36I12.36J453.13 
N1036G3X-273.71Y190.42I-
288.44J176.89 
N1037G2X-331.52Y272.59I12.35J453.12 
N1038G3X-366.94Y253.99I-
349.23J263.29 
N1039G3X-
355.62Y233.78I12.36J453.13M05 
N1040G0X-535.13Y220.61 
N1041G1X-539.47Y211.59M04 
N1042G3X-501.18Y163.36I-
185.65J453.13 
N1043G3X-471.72Y190.42I-
486.45J176.89 
N1044G2X-529.54Y272.59I-
185.66J453.12 
N1045G3X-564.95Y253.99I-
547.24J263.29 
N1046G3X-539.47Y211.59I-
185.65J453.13M05 
N1047G0X-726.26Y252.38 
N1048G1X-721.20Y261.01M04 
N1049G2X-727.54Y272.59I-
383.66J453.12 
N1050G3X-762.95Y253.99I-
745.24J263.29 
N1051G3X-699.18Y163.36I-
383.65J453.13 
N1052G3X-669.72Y190.42I-
684.45J176.89 
N1053G2X-721.20Y261.01I-
383.66J453.12M05 
N1054G0X-859.57Y551.34 
N1055G1X-849.70Y549.75M04 
N1056G3X-
806.30Y442.09I1906.08J1598.23 
N1057G2X-843.09Y426.41I-
824.70J434.25 
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N1058G2X-
893.26Y551.90I1906.08J1598.23 
N1059G2X-855.80Y565.91I-
874.53J558.91 
N1060G3X-
849.70Y549.75I1906.08J1598.23M05 
N1061G0X-928.22Y720.65 
N1062G1X-933.22Y711.99M04 
N1063G2Y751.99I-933.22J731.99 
N1064G2Y711.99I-933.22J731.99M05 
N1065G0X-686.99Y552.26 
N1066G1X-696.30Y555.90M04 
N1067G2X-657.80Y565.91I-
676.53J558.91 
N1068G3X-
608.30Y442.09I2104.08J1598.23 
N1069G2X-645.09Y426.41I-
626.70J434.25 
N1070G2X-
695.26Y551.90I2104.08J1598.23 
N1071G2X-696.30Y555.90I-
676.53J558.91M05 
N1072G0X-723.18Y734.95 
N1073G1X-715.52Y728.52M04 
N1074G2X-754.91Y735.45I-
735.22J731.99 
N1075G2X-715.52Y728.52I-
735.22J731.99M05 
N1076G0X-487.39Y550.25 
N1077G1X-497.25Y551.90M04 
N1078G2X-459.79Y565.91I-
478.52J558.91 
N1079G3X-
410.29Y442.09I2302.09J1598.23 
N1080G2X-447.08Y426.41I-
428.69J434.25 
N1081G2X-
497.25Y551.90I2302.09J1598.23M05 
N1082G0X-542.57Y743.16 
N1083G1X-537.84Y751.98M04 
N1084G2X-536.57Y712.00I-
537.21J731.99 
N1085G2X-537.84Y751.98I-
537.21J731.99M05 
N1086G0X-534.82Y2248.07 
N1087G1X-539.82Y2256.73M04 

N1088G1X-591.36 
N1089G3X-596.84Y2253.54I-
591.53J2250.73 
N1090G3X-
766.18Y1615.84I532.21J1612.38 
N1091G3X-
596.84Y978.14I532.21J1619.30 
N1092G3X-591.36Y974.95I-
591.53J980.95 
N1093G1X-488.29 
N1094G3X-482.29Y980.95I-
488.29J980.95 
N1095G1Y2250.73 
N1096G3X-488.29Y2256.73I-
488.29J2250.73 
N1097G1X-539.82M05 
N1098G0X-542.21Y2511.03 
N1099G1X-537.21Y2519.69M04 
N1100G2Y2479.69I-537.21J2499.69 
N1101G2Y2519.69I-537.21J2499.69M05 
N1102G0X-746.56Y2494.69 
N1103G1X-755.22Y2499.69M04 
N1104G2X-715.22I-735.22J2499.69 
N1105G2X-755.22I-735.22J2499.69M05 
N1106G0X-944.56Y2494.69 
N1107G1X-953.22Y2499.69M04 
N1108G2X-913.22I-933.22J2499.69 
N1109G2X-953.22I-933.22J2499.69M05 
N1110G0X-833.17Y2806.47 
N1111G1X-843.09Y2805.27M04 
N1112G3X-
893.26Y2679.77I1906.08J1633.45 
N1113G3X-855.80Y2665.77I-
874.53J2672.77 
N1114G2X-
806.30Y2789.59I1906.08J1633.44 
N1115G3X-843.09Y2805.27I-
824.70J2797.43M05 
N1116G0X-635.60Y2805.46 
N1117G1X-645.53Y2804.25M04 
N1118G3X-
695.26Y2679.77I2104.08J1633.45 
N1119G3X-657.80Y2665.77I-
676.53J2672.77 
 



 59 

 
N1120G2X-
608.30Y2789.59I2104.08J1633.44 
N1121G3X-645.09Y2805.27I-
626.70J2797.43 
N1122G3X-
645.53Y2804.25I2104.08J1633.45M05 
N1123G0X-437.16Y2806.47 
N1124G1X-447.08Y2805.27M04 
N1125G3X-
497.25Y2679.77I2302.09J1633.45 
N1126G3X-459.79Y2665.77I-
478.52J2672.77 
N1127G2X-
410.29Y2789.59I2302.09J1633.44 
N1128G3X-447.08Y2805.27I-
428.69J2797.43M05 
N1129G0X-344.93Y2998.89 
N1130G1X-354.93Y2999.06M04 
N1131G3X-
366.94Y2977.68I12.36J2778.55 
N1132G3X-331.52Y2959.09I-
349.23J2968.39 
N1133G2X-
273.71Y3041.26I12.35J2778.56 
N1134G3X-303.17Y3068.32I-
288.44J3054.79 
N1135G3X-
354.93Y2999.06I12.36J2778.55M05 
N1136G0X-491.42Y3066.14 
N1137G1X-501.18Y3068.32M04 
N1138G3X-564.95Y2977.68I-
185.65J2778.55 
N1139G3X-529.54Y2959.09I-
547.24J2968.39 
N1140G2X-471.72Y3041.26I-
185.66J2778.56 
N1141G3X-501.18Y3068.32I-
486.45J3054.79M05 
N1142G0X-689.42Y3066.14 
N1143G1X-699.18Y3068.32M04 
N1144G3X-762.95Y2977.68I-
383.65J2778.55 
N1145G3X-727.54Y2959.09I-
745.24J2968.39 
 

N1146G2X-669.72Y3041.26I-
383.66J2778.56 
N1147G3X-699.18Y3068.32I-
684.45J3054.79M05 
N1148G0X-511.17Y3221.25 
N1149G1X-519.83Y3216.25M04 
N1150G3X-793.63Y2983.59I-
383.65J2778.55 
N1151G3X-
822.67Y2923.89I1906.02J1633.48 
N1152G1X-806.07Y2907.57 
N1153G2X-815.66Y2882.74I-
816.23J2897.23 
N1154G1X-842.23Y2881.69 
N1155G3X-
911.61Y2716.01I1906.00J1633.48 
N1156G1X-946.58Y2625.01 
N1157G1X-929.57Y2610.30 
N1158G2X-937.56Y2584.91I-
939.05J2599.33 
N1159G1X-962.99Y2582.28 
N1160G1X-1088.14Y2256.53 
N1161G1X-1070.62Y2241.47 
N1162G2X-1078.53Y2216.05I-
1080.07J2230.47 
N1163G1X-1104.77Y2213.25 
N1164G1X-1140.73Y2119.67 
N1165G3Y1112.00I170.83J1615.84 
N1166G1X-1104.77Y1018.42 
N1167G1X-1078.53Y1015.62 
N1168G2X-1070.62Y990.21I-
1080.07J1001.21 
N1169G1X-1088.14Y975.15 
N1170G1X-962.99Y649.40 
N1171G1X-937.56Y646.77 
N1172G2X-929.57Y621.38I-
939.05J632.35 
N1173G1X-946.58Y606.67 
N1174G1X-911.61Y515.67 
N1175G3X-
842.23Y349.98I1905.98J1598.18 
N1176G1X-815.66Y348.94 
N1177G2X-806.07Y324.11I-
816.23J334.45 
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N1178G1X-822.67Y307.79 
N1179G3X-
793.63Y248.09I1905.96J1598.17 
N1180G3X-519.83Y15.42I-383.65J453.13 
N1181G1Y121.61 
N1182G2X-704.20Y292.82I-
383.64J453.13 
N1183G2X-
893.49Y773.57I1905.99J1598.19 
N1184G3X-906.78Y807.16I-
1085.34J717.05 
N1185G1X-1011.17Y1014.04 
N1186G2X-
1162.19Y1615.84I126.21J1619.30 
N1187G2X-
1011.17Y2217.64I126.20J1612.38 
N1188G1X-906.78Y2424.52 
N1189G3X-893.49Y2458.11I-
1085.33J2514.62 
N1190G2X-
704.20Y2938.86I1905.99J1633.49 
N1191G2X-519.83Y3110.07I-
383.65J2778.55 
N1192G1Y3216.25M05 
N1193G0X-313.17Y3221.25 
N1194G1X-321.83Y3216.25M04 
N1195G3X-595.63Y2983.59I-
185.65J2778.55 
N1196G3X-
624.67Y2923.89I2104.02J1633.48 
N1197G1X-608.07Y2907.57 
N1198G2X-617.66Y2882.74I-
618.23J2897.23 
N1199G1X-644.23Y2881.69 
N1200G3X-
713.61Y2716.01I2104.00J1633.48 
N1201G1X-748.58Y2625.01 
N1202G1X-731.57Y2610.30 
N1203G2X-739.56Y2584.91I-
741.05J2599.33 
N1204G1X-764.99Y2582.28 
N1205G1X-890.14Y2256.53 
N1206G1X-872.62Y2241.47 
N1207G2X-880.53Y2216.05I-
882.07J2230.47 
 

N1208G1X-906.77Y2213.25 
N1209G1X-942.73Y2119.67 
N1210G3Y1112.00I368.83J1615.84 
N1211G1X-906.77Y1018.42 
N1212G1X-880.53Y1015.62 
N1213G2X-872.62Y990.21I-
882.07J1001.21 
N1214G1X-890.14Y975.15 
N1215G1X-764.99Y649.40 
N1216G1X-739.56Y646.77 
N1217G2X-731.57Y621.38I-
741.05J632.35 
N1218G1X-748.58Y606.67 
N1219G1X-713.61Y515.67 
N1220G3X-
644.23Y349.98I2103.98J1598.18 
N1221G1X-617.66Y348.94 
N1222G2X-608.07Y324.11I-
618.23J334.45 
N1223G1X-624.67Y307.79 
N1224G3X-
595.63Y248.09I2103.96J1598.17 
N1225G3X-321.83Y15.42I-185.65J453.13 
N1226G1Y121.61 
N1227G2X-506.20Y292.82I-
185.64J453.13 
N1228G2X-
695.49Y773.57I2103.99J1598.19 
N1229G3X-708.78Y807.16I-
887.34J717.05 
N1230G1X-813.17Y1014.04 
N1231G2X-
964.19Y1615.84I324.21J1619.30 
N1232G2X-
813.17Y2217.64I324.20J1612.38 
N1233G1X-708.78Y2424.52 
N1234G3X-695.49Y2458.11I-
887.33J2514.62 
N1235G2X-
506.20Y2938.86I2103.99J1633.49 
N1236G2X-321.83Y3110.07I-
185.65J2778.55 
N1237G1Y3216.25M05 
N1238G0X-115.16Y3221.25 
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N1239G1X-123.82Y3216.25M04 
N1240G3X-
397.62Y2983.59I12.36J2778.55 
N1241G3X-
426.66Y2923.89I2302.03J1633.48 
N1242G1X-410.06Y2907.57 
N1243G2X-419.65Y2882.74I-
420.22J2897.23 
N1244G1X-446.22Y2881.69 
N1245G3X-
515.60Y2716.01I2302.01J1633.48 
N1246G3X-
550.56Y2625.01I2284.13J1588.12 
N1247G1X-533.84Y2610.54 
N1248G2X-541.83Y2585.15I-
541.98J2599.15 
N1249G1X-566.98Y2582.28 
N1250G3X-
692.13Y2256.53I2183.33J1338.69 
N1251G1X-674.61Y2241.47 
N1252G2X-682.52Y2216.05I-
684.06J2230.47 
N1253G1X-708.76Y2213.25 
N1254G1X-744.72Y2119.67 
N1255G3X-
838.18Y1615.84I566.82J1615.79 
N1256G3X-
744.72Y1112.00I566.82J1615.89 
N1257G1X-708.76Y1018.42 
N1258G1X-682.52Y1015.62 
N1259G2X-674.61Y990.21I-
684.06J1001.21 
N1260G1X-692.13Y975.15 
 

N1261G3X-
566.98Y649.40I2183.33J1892.98 
N1262G1X-541.83Y646.53 
N1263G2X-533.84Y621.14I-
541.98J632.53 
N1264G1X-550.56Y606.67 
N1265G3X-
515.60Y515.67I2284.16J1643.56 
N1266G3X-
446.22Y349.98I2301.99J1598.18 
N1267G1X-419.65Y348.94 
N1268G2X-410.06Y324.11I-
420.22J334.45 
N1269G1X-426.66Y307.79 
N1270G3X-
397.62Y248.09I2301.97J1598.17 
N1271G3X-123.82Y15.42I12.36J453.13 
N1272G1Y121.61 
N1273G2X-308.19Y292.82I12.37J453.13 
N1274G2X-
435.05Y586.58I2303.62J1595.03 
N1275G2X-435.44Y588.75I-
429.14J588.75 
N1276G1X-435.04Y2645.10 
N1277G2X-434.65Y2647.29I-
428.74J2645.10 
N1278G2X-
308.19Y2938.86I2301.99J1633.49 
N1279G2X-
123.82Y3110.07I12.36J2778.55 
N1280G1Y3216.25M05 
N1281G99 
& 
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2. CNC CODE FOR LAYOUT 6 
 
% 
N1G29X1135.8Y3222.3P1H1 
N2G51X0.0Y0.0O0 
N1001G0X-284.45Y165.15 
N1002G1X-274.91Y162.16M04 
N1003G3X-273.71Y190.42I-
288.44J176.89 
N1004G2X-331.53Y272.59I12.35J453.12 
N1005G3X-366.94Y253.99I-
349.23J263.29 
N1006G3X-303.17Y163.36I12.36J453.13 
N1007G3X-274.91Y162.16I-
288.44J176.89M05 
N1008G0X-475.33Y171.41 
N1009G1X-466.47Y176.04M04 
N1010G3X-471.72Y190.42I-
486.45J176.89 
N1011G2X-529.54Y272.59I-
185.66J453.12 
N1012G3X-564.95Y253.99I-
547.24J263.29 
N1013G3X-501.18Y163.36I-
185.65J453.13 
N1014G3X-466.47Y176.04I-
486.45J176.89M05 
N1015G0X-689.93Y165.77 
N1016G1X-685.30Y156.91M04 
N1017G3X-669.72Y190.42I-
684.45J176.89 
N1018G2X-727.54Y272.59I-
383.66J453.12 
N1019G3X-762.95Y253.99I-
745.24J263.29 
N1020G3X-699.18Y163.36I-
383.65J453.13 
N1021G3X-685.30Y156.91I-
684.45J176.89M05 
N1022G0X-883.40Y550.25 
N1023G1X-893.26Y551.90M04 
N1024G2X-855.80Y565.91I-
874.53J558.91 
N1025G3X-
806.30Y442.09I1906.08J1598.23 
N1026G2X-843.09Y426.41I-
824.70J434.25 
 

N1027G2X-
893.26Y551.90I1906.08J1598.23M05 
N1028G0X-686.99Y552.26 
N1029G1X-696.30Y555.90M04 
N1030G2X-657.80Y565.91I-
676.53J558.91 
N1031G3X-
608.30Y442.09I2104.08J1598.23 
N1032G2X-645.09Y426.41I-
626.70J434.25 
N1033G2X-
695.26Y551.90I2104.08J1598.23 
N1034G2X-696.30Y555.90I-
676.53J558.91M05 
N1035G0X-487.39Y550.25 
N1036G1X-497.25Y551.90M04 
N1037G2X-459.79Y565.91I-
478.52J558.91 
N1038G3X-
410.29Y442.09I2302.09J1598.23 
N1039G2X-447.08Y426.41I-
428.69J434.25 
N1040G2X-
497.25Y551.90I2302.09J1598.23M05 
N1041G0X-525.87Y736.99 
N1042G1X-517.21Y731.99M04 
N1043G2X-557.21I-537.21J731.99 
N1044G2X-517.21I-537.21J731.99M05 
N1045G0X-732.18Y744.00 
N1046G1X-722.91Y747.75M04 
N1047G2X-747.53Y716.22I-
735.22J731.99 
N1048G2X-722.91Y747.75I-
735.22J731.99M05 
N1049G0X-928.22Y720.65 
N1050G1X-933.22Y711.99M04 
N1051G2Y751.99I-933.22J731.99 
N1052G2Y711.99I-933.22J731.99M05 
N1053G0X-490.95Y2245.73 
N1054G1X-482.29Y2250.73M04 
N1055G3X-488.29Y2256.73I-
488.29J2250.73 
N1056G1X-591.36 
N1057G3X-596.84Y2253.54I-
591.53J2250.73 
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N1058G3X-
766.18Y1615.84I532.21J1612.38 
N1059G3X-
596.84Y978.14I532.21J1619.30 
N1060G3X-591.36Y974.95I-
591.53J980.95 
N1061G1X-488.29 
N1062G3X-482.29Y980.95I-
488.29J980.95 
N1063G1Y2250.73M05 
N1064G0X-542.21Y2511.03 
N1065G1X-537.21Y2519.69M04 
N1066G2Y2479.69I-537.21J2499.69 
N1067G2Y2519.69I-537.21J2499.69M05 
N1068G0X-746.56Y2494.69 
N1069G1X-755.22Y2499.69M04 
N1070G2X-715.22I-735.22J2499.69 
N1071G2X-755.22I-735.22J2499.69M05 
N1072G0X-944.56Y2494.69 
N1073G1X-953.22Y2499.69M04 
N1074G2X-913.22I-933.22J2499.69 
N1075G2X-953.22I-933.22J2499.69M05 
N1076G0X-833.17Y2806.47 
N1077G1X-843.09Y2805.27M04 
N1078G3X-
893.26Y2679.77I1906.08J1633.45 
N1079G3X-855.80Y2665.77I-
874.53J2672.77 
N1080G2X-
806.30Y2789.59I1906.08J1633.44 
N1081G3X-843.09Y2805.27I-
824.70J2797.43M05 
N1082G0X-635.60Y2805.46 
N1083G1X-645.53Y2804.25M04 
N1084G3X-
695.26Y2679.77I2104.08J1633.45 
N1085G3X-657.80Y2665.77I-
676.53J2672.77 
N1086G2X-
608.30Y2789.59I2104.08J1633.44 
N1087G3X-645.09Y2805.27I-
626.70J2797.43 
N1088G3X-
645.53Y2804.25I2104.08J1633.45M05 
N1089G0X-437.16Y2806.47 
N1090G1X-447.08Y2805.27M04 

N1091G3X-
497.25Y2679.77I2302.09J1633.45 
N1092G3X-459.79Y2665.77I-
478.52J2672.77 
N1093G2X-
410.29Y2789.59I2302.09J1633.44 
N1094G3X-447.08Y2805.27I-
428.69J2797.43M05 
N1095G0X-293.41Y3066.14 
N1096G1X-303.17Y3068.32M04 
N1097G3X-
366.94Y2977.68I12.36J2778.55 
N1098G3X-331.52Y2959.09I-
349.23J2968.39 
N1099G2X-
273.71Y3041.26I12.35J2778.56 
N1100G3X-303.17Y3068.32I-
288.44J3054.79M05 
N1101G0X-491.42Y3066.14 
N1102G1X-501.18Y3068.32M04 
N1103G3X-564.95Y2977.68I-
185.65J2778.55 
N1104G3X-529.54Y2959.09I-
547.24J2968.39 
N1105G2X-471.72Y3041.26I-
185.66J2778.56 
N1106G3X-501.18Y3068.32I-
486.45J3054.79M05 
N1107G0X-689.42Y3066.14 
N1108G1X-699.18Y3068.32M04 
N1109G3X-762.95Y2977.68I-
383.65J2778.55 
N1110G3X-727.54Y2959.09I-
745.24J2968.39 
N1111G2X-669.72Y3041.26I-
383.66J2778.56 
N1112G3X-699.18Y3068.32I-
684.45J3054.79M05 
N1113G0X-511.17Y3221.25 
N1114G1X-519.83Y3216.25M04 
N1115G3X-793.63Y2983.59I-
383.65J2778.55 
N1116G3X-
822.67Y2923.89I1906.02J1633.48 
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N1117G1X-806.07Y2907.57 
N1118G2X-815.66Y2882.74I-
816.23J2897.23 
N1119G1X-842.23Y2881.69 
N1120G3X-
911.61Y2716.01I1906.00J1633.48 
N1121G1X-946.58Y2625.01 
N1122G1X-929.57Y2610.30 
N1123G2X-937.56Y2584.91I-
939.05J2599.33 
N1124G1X-962.99Y2582.28 
N1125G1X-1088.14Y2256.53 
N1126G1X-1070.62Y2241.47 
N1127G2X-1078.53Y2216.05I-
1080.07J2230.47 
N1128G1X-1104.77Y2213.25 
N1129G1X-1140.73Y2119.67 
N1130G3Y1112.00I170.83J1615.84 
N1131G1X-1104.77Y1018.42 
N1132G1X-1078.53Y1015.62 
N1133G2X-1070.62Y990.21I-
1080.07J1001.21 
N1134G1X-1088.14Y975.15 
N1135G1X-962.99Y649.40 
N1136G1X-937.56Y646.77 
N1137G2X-929.57Y621.38I-
939.05J632.35 
N1138G1X-946.58Y606.67 
N1139G1X-911.61Y515.67 
N1140G3X-
842.23Y349.98I1905.98J1598.18 
N1141G1X-815.66Y348.94 
N1142G2X-806.07Y324.11I-
816.23J334.45 
N1143G1X-822.67Y307.79 
N1144G3X-
793.63Y248.09I1905.96J1598.17 
N1145G3X-519.83Y15.42I-383.65J453.13 
N1146G1Y121.61 
N1147G2X-704.20Y292.82I-
383.64J453.13 
N1148G2X-
893.49Y773.57I1905.99J1598.19 
N1149G3X-906.78Y807.16I-
1085.34J717.05 
 

N1150G1X-1011.17Y1014.04 
N1151G2X-
1162.19Y1615.84I126.21J1619.30 
N1152G2X-
1011.17Y2217.64I126.20J1612.38 
N1153G1X-906.78Y2424.52 
N1154G3X-893.49Y2458.11I-
1085.33J2514.62 
N1155G2X-
704.20Y2938.86I1905.99J1633.49 
N1156G2X-519.83Y3110.07I-
383.65J2778.55 
N1157G1Y3216.25M05 
N1158G0X-313.17Y3221.25 
N1159G1X-321.83Y3216.25M04 
N1160G3X-595.63Y2983.59I-
185.65J2778.55 
N1161G3X-
624.67Y2923.89I2104.02J1633.48 
N1162G1X-608.07Y2907.57 
N1163G2X-617.66Y2882.74I-
618.23J2897.23 
N1164G1X-644.23Y2881.69 
N1165G3X-
713.61Y2716.01I2104.00J1633.48 
N1166G1X-748.58Y2625.01 
N1167G1X-731.57Y2610.30 
N1168G2X-739.56Y2584.91I-
741.05J2599.33 
N1169G1X-764.99Y2582.28 
N1170G1X-890.14Y2256.53 
N1171G1X-872.62Y2241.47 
N1172G2X-880.53Y2216.05I-
882.07J2230.47 
N1173G1X-906.77Y2213.25 
N1174G1X-942.73Y2119.67 
N1175G3Y1112.00I368.83J1615.84 
N1176G1X-906.77Y1018.42 
N1177G1X-880.53Y1015.62 
N1178G2X-872.62Y990.21I-
882.07J1001.21 
N1179G1X-890.14Y975.15 
N1180G1X-764.99Y649.40 
N1181G1X-739.56Y646.77 
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N1182G2X-731.57Y621.38I-
741.05J632.35 
N1183G1X-748.58Y606.67 
N1184G1X-713.61Y515.67 
N1185G3X-
644.23Y349.98I2103.98J1598.18 
N1186G1X-617.66Y348.94 
N1187G2X-608.07Y324.11I-
618.23J334.45 
N1188G1X-624.67Y307.79 
N1189G3X-
595.63Y248.09I2103.96J1598.17 
N1190G3X-321.83Y15.42I-185.65J453.13 
N1191G1Y121.61 
N1192G2X-506.20Y292.82I-
185.64J453.13 
N1193G2X-
695.49Y773.57I2103.99J1598.19 
N1194G3X-708.78Y807.16I-
887.34J717.05 
N1195G1X-813.17Y1014.04 
N1196G2X-
964.19Y1615.84I324.21J1619.30 
N1197G2X-
813.17Y2217.64I324.20J1612.38 
N1198G1X-708.78Y2424.52 
N1199G3X-695.49Y2458.11I-
887.33J2514.62 
N1200G2X-
506.20Y2938.86I2103.99J1633.49 
N1201G2X-321.83Y3110.07I-
185.65J2778.55 
N1202G1Y3216.25M05 
N1203G0X-115.16Y3221.25 
N1204G1X-123.82Y3216.25M04 
N1205G3X-
397.62Y2983.59I12.36J2778.55 
N1206G3X-
426.66Y2923.89I2302.03J1633.48 
N1207G1X-410.06Y2907.57 
N1208G2X-419.65Y2882.74I-
420.22J2897.23 
N1209G1X-446.22Y2881.69 
N1210G3X-
515.60Y2716.01I2302.01J1633.48 
 

N1211G3X-
550.56Y2625.01I2284.13J1588.12 
N1212G1X-533.84Y2610.54 
N1213G2X-541.83Y2585.15I-
541.98J2599.15 
N1214G1X-566.98Y2582.28 
N1215G3X-
692.13Y2256.53I2183.33J1338.69 
N1216G1X-674.61Y2241.47 
N1217G2X-682.52Y2216.05I-
684.06J2230.47 
N1218G1X-708.76Y2213.25 
N1219G1X-744.71Y2119.67 
N1220G3X-
838.18Y1615.84I566.82J1615.79 
N1221G3X-
744.72Y1112.00I566.82J1615.89 
N1222G1X-708.76Y1018.42 
N1223G1X-682.52Y1015.62 
N1224G2X-674.61Y990.21I-
684.06J1001.21 
N1225G1X-692.13Y975.15 
N1226G3X-
566.98Y649.40I2183.33J1892.98 
N1227G1X-541.83Y646.53 
N1228G2X-533.84Y621.14I-
541.98J632.53 
N1229G1X-550.56Y606.67 
N1230G3X-
515.60Y515.67I2284.16J1643.56 
N1231G3X-
446.22Y349.98I2301.99J1598.18 
N1232G1X-419.65Y348.94 
N1233G2X-410.06Y324.11I-
420.22J334.45 
N1234G1X-426.66Y307.79 
N1235G3X-
397.62Y248.09I2301.97J1598.17 
N1236G3X-123.82Y15.42I12.36J453.13 
N1237G1Y121.61 
N1238G2X-308.19Y292.82I12.37J453.13 
N1239G2X-
435.05Y586.58I2303.62J1595.03 
N1240G2X-435.44Y588.75I-
429.14J588.75 
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N1241G1X-435.04Y2645.10 
N1242G2X-434.65Y2647.29I-
428.74J2645.10 
N1243G2X-
308.19Y2938.86I2301.99J1633.49 
N1244G2X-
123.82Y3110.07I12.36J2778.55 
N1245G1Y3216.25M05 
N1246G99 
& 

 

 
 
3. CNC CODE FOR LAYOUT 7 
 
% 
N1G29X1122.0Y3231.6P1H1 
N2G51X0.0Y0.0O0 
N1001G0X504.76Y263.29 
N1002G1X522.46Y272.59M04 
N1003G3X487.05Y253.99I504.76J263.29 
N1004G3X550.82Y163.36I866.35J453.13 
N1005G3X580.28Y190.42I565.55J176.89 
N1006G2X522.46Y272.59I866.34J453.12
M05 
N1007G0X375.47Y558.91 
N1008G1X394.20Y565.91M04 
N1009G3X443.70Y442.09I3156.08J1598.
23 
N1010G2X406.91Y426.41I425.30J434.25 
N1011G2X356.74Y551.90I3156.08J1598.
23 
N1012G2X394.20Y565.91I375.47J558.91
M05 
N1013G0X336.78Y731.99 
N1014G3X296.78I316.78J731.99M04 
N1015G3X336.78I316.78J731.99M05 
N1016G0Y2499.69 
N1017G3X296.78I316.78J2499.69M04 
N1018G3X336.78I316.78J2499.69M05 
N1019G0X424.97Y2796.59 
N1020G1X443.70Y2789.59M04 
N1021G3X406.91Y2805.27I425.30J2797.
43 
N1022G3X356.74Y2679.77I3156.08J1633
.45 
N1023G3X394.20Y2665.77I375.47J2672.
77 

N1024G2X443.70Y2789.59I3156.08J1633.
44M05 
N1025G0X562.57Y3050.56 
N1026G1X580.28Y3041.26M04 
N1027G3X550.82Y3068.32I565.55J3054.7
9 
 
N1028G3X487.05Y2977.68I866.35J2778.5
5 
N1029G3X522.46Y2959.09I504.76J2968.3
9 
N1030G2X580.28Y3041.26I866.34J2778.5
6M05 
N1031G0X725.71Y3230.58 
N1032G1X730.17Y3216.25M04 
N1033G1Y3110.07 
N1034G3X545.80Y2938.86I866.35J2778.5
5 
N1035G3X356.51Y2458.11I3155.99J1633.
49 
N1036G2X343.22Y2424.52I164.67J2514.6
2 
N1037G1X238.83Y2217.64 
N1038G3X87.81Y1615.84I1376.20J1612.3
8 
N1039G3X238.83Y1014.04I1376.21J1619.
30 
N1040G1X343.22Y807.16 
N1041G2X356.51Y773.57I164.66J717.05 
N1042G3X545.80Y292.82I3155.99J1598.1
9 
N1043G3X730.17Y121.61I866.36J453.13 
N1044G1Y15.42 
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N1045G2X456.37Y248.09I866.35J453.13 
N1046G2X427.33Y307.79I3155.96J1598.
17 
N1047G1X443.93Y324.11 
N1048G3X434.34Y348.94I433.77J334.45 
N1049G1X407.77Y349.98 
N1050G2X338.39Y515.67I3155.98J1598.
18 
N1051G1X303.42Y606.67 
N1052G1X320.43Y621.38 
N1053G3X312.44Y646.77I310.95J632.35 
N1054G1X287.01Y649.40 
N1055G1X161.86Y975.15 
N1056G1X179.38Y990.21 
N1057G3X171.47Y1015.62I169.93J1001.
21 
N1058G1X145.23Y1018.42 
N1059G1X109.27Y1112.00 
N1060G2Y2119.67I1420.83J1615.84 
N1061G1X145.23Y2213.25 
N1062G1X171.47Y2216.05 
N1063G3X179.38Y2241.47I169.93J2230.
47 
N1064G1X161.86Y2256.53 
N1065G1X287.01Y2582.28 
N1066G1X312.44Y2584.91 
N1067G3X320.43Y2610.30I310.95J2599.
33 
N1068G1X303.42Y2625.01 
N1069G1X338.39Y2716.01 
N1070G2X407.77Y2881.69I3156.00J1633
.48 
N1071G1X434.34Y2882.74 
N1072G3X443.93Y2907.57I433.77J2897.
23 
N1073G1X427.33Y2923.89 
N1074G2X456.37Y2983.59I3156.02J1633
.48 
N1075G2X730.17Y3216.25I866.35J2778.
55M05 
N1076G0X700.18Y263.29 
N1077G1X717.89Y272.59M04 
N1078G3X682.47Y253.99I700.18J263.29 
N1079G3X746.24Y163.36I1061.77J453.1
3 
N1080G3X775.71Y190.42I760.98J176.89 
 

N1081G2X717.89Y272.59I1061.77J453.12
M05 
N1082G0X570.89Y558.91 
N1083G1X589.63Y565.91M04 
N1084G3X639.13Y442.09I3351.50J1598.2
3 
N1085G2X602.33Y426.41I620.73J434.25 
N1086G2X552.16Y551.90I3351.50J1598.2
3 
N1087G2X589.63Y565.91I570.89J558.91
M05 
N1088G0X532.21Y731.99 
N1089G3X492.21I512.21J731.99M04 
N1090G3X532.21I512.21J731.99M05 
N1091G0Y2499.69 
N1092G3X492.21I512.21J2499.69M04 
N1093G3X532.21I512.21J2499.69M05 
N1094G0X620.39Y2796.59 
N1095G1X639.13Y2789.59M04 
N1096G3X602.33Y2805.27I620.73J2797.4
3 
N1097G3X552.16Y2679.77I3351.50J1633.
45 
N1098G3X589.63Y2665.77I570.89J2672.7
7 
N1099G2X639.13Y2789.59I3351.50J1633.
44M05 
N1100G0X758.00Y3050.56 
N1101G1X775.71Y3041.26M04 
N1102G3X746.24Y3068.32I760.98J3054.7
9 
N1103G3X682.47Y2977.68I1061.77J2778.
55 
N1104G3X717.89Y2959.09I700.18J2968.3
9 
N1105G2X775.71Y3041.26I1061.77J2778.
56M05 
N1106G0X921.14Y3230.58 
N1107G1X925.59Y3216.25M04 
N1108G1Y3110.07 
N1109G3X741.23Y2938.86I1061.77J2778.
55 
N1110G3X551.94Y2458.11I3351.41J1633.
49 
N1111G2X538.64Y2424.52I360.09J2514.6
2 
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N1112G1X434.25Y2217.64 
N1113G3X283.23Y1615.84I1571.63J1612
.38 
N1114G3X434.25Y1014.04I1571.63J1619
.30 
N1115G1X538.64Y807.16 
N1116G2X551.94Y773.57I360.08J717.05 
N1117G3X741.23Y292.82I3351.41J1598.
19 
N1118G3X925.59Y121.61I1061.78J453.1
3 
N1119G1Y15.42 
N1120G2X651.79Y248.09I1061.78J453.1
3 
N1121G2X622.75Y307.79I3351.38J1598.
17 
N1122G1X639.36Y324.11 
N1123G3X629.76Y348.94I629.19J334.45 
N1124G1X603.19Y349.98 
N1125G2X533.81Y515.67I3351.40J1598.
18 
N1126G1X498.85Y606.67 
N1127G1X515.85Y621.38 
N1128G3X507.86Y646.77I506.37J632.35 
N1129G1X482.43Y649.40 
N1130G1X357.28Y975.15 
N1131G1X374.80Y990.21 
N1132G3X366.89Y1015.62I365.35J1001.
21 
N1133G1X340.65Y1018.42 
N1134G1X304.70Y1112.00 
N1135G2Y2119.67I1616.25J1615.84 
N1136G1X340.65Y2213.25 
N1137G1X366.89Y2216.05 
N1138G3X374.80Y2241.47I365.36J2230.
47 
N1139G1X357.28Y2256.53 
N1140G1X482.43Y2582.28 
N1141G1X507.86Y2584.91 
N1142G3X515.85Y2610.30I506.37J2599.
33 
N1143G1X498.85Y2625.01 
N1144G1X533.81Y2716.01 
N1145G2X603.19Y2881.69I3351.42J1633
.48 
 

N1146G1X629.76Y2882.74 
N1147G3X639.36Y2907.57I629.19J2897.2
3 
N1148G1X622.75Y2923.89 
N1149G2X651.79Y2983.59I3351.45J1633.
48 
N1150G2X925.59Y3216.25I1061.78J2778.
55M05 
N1151G0X895.60Y263.29 
N1152G1X913.31Y272.59M04 
N1153G3X877.89Y253.99I895.60J263.29 
N1154G3X941.67Y163.36I1257.19J453.13 
N1155G3X971.13Y190.42I956.40J176.89 
N1156G2X913.31Y272.59I1257.19J453.12
M05 
N1157G0X766.32Y558.91 
N1158G1X785.05Y565.91M04 
N1159G3X834.55Y442.09I3546.92J1598.2
3 
N1160G2X797.75Y426.41I816.15J434.25 
N1161G2X747.58Y551.90I3546.93J1598.2
3 
N1162G2X785.05Y565.91I766.32J558.91
M05 
N1163G0X727.63Y731.99 
N1164G3X687.63I707.63J731.99M04 
N1165G3X727.63I707.63J731.99M05 
N1166G0Y2499.69 
N1167G3X687.63I707.63J2499.69M04 
N1168G3X727.63I707.63J2499.69M05 
N1169G0X815.81Y2796.59 
N1170G1X834.55Y2789.59M04 
N1171G3X797.75Y2805.27I816.15J2797.4
3 
N1172G3X747.58Y2679.77I3546.93J1633.
45 
N1173G3X785.05Y2665.77I766.32J2672.7
7 
N1174G2X834.55Y2789.59I3546.92J1633.
44M05 
N1175G0X953.42Y3050.56 
N1176G1X971.13Y3041.26M04 
N1177G3X941.67Y3068.32I956.40J3054.7
9 
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N1178G3X877.89Y2977.68I1257.19J2778
.55 
N1179G3X913.31Y2959.09I895.60J2968.
39 
N1180G2X971.13Y3041.26I1257.19J2778
.56M05 
N1181G0X1116.56Y3230.58 
N1182G1X1121.02Y3216.25M04 
N1183G1Y3110.07 
N1184G3X936.65Y2938.86I1257.20J2778
.55 
N1185G3X747.36Y2458.11I3546.83J1633
.49 
N1186G2X734.06Y2424.52I555.52J2514.
62 
N1187G1X629.67Y2217.64 
N1188G3X478.65Y1615.84I1767.05J1612
.38 
N1189G3X629.67Y1014.04I1767.05J1619
.30 
N1190G1X734.06Y807.16 
N1191G2X747.36Y773.57I555.51J717.05 
N1192G3X936.65Y292.82I3546.84J1598.
19 
N1193G3X1121.02Y121.61I1257.20J453.
13 
N1194G1Y15.42 
N1195G2X847.21Y248.09I1257.20J453.1
3 
N1196G2X818.17Y307.79I3546.81J1598.
17 
N1197G1X834.78Y324.11 
N1198G3X825.19Y348.94I824.61J334.45 
N1199G1X798.61Y349.98 

N1200G2X729.23Y515.67I3546.82J1598.1
8 
N1201G1X694.27Y606.67 
N1202G1X711.28Y621.38 
N1203G3X703.28Y646.77I701.79J632.35 
N1204G1X677.85Y649.40 
N1205G1X552.70Y975.15 
N1206G1X570.23Y990.21 
N1207G3X562.32Y1015.62I560.78J1001.2
1 
N1208G1X536.07Y1018.42 
N1209G1X500.12Y1112.00 
N1210G2Y2119.67I1811.67J1615.84 
N1211G1X536.07Y2213.25 
N1212G1X562.32Y2216.05 
N1213G3X570.23Y2241.47I560.78J2230.4
7 
N1214G1X552.70Y2256.53 
N1215G1X677.85Y2582.28 
N1216G1X703.28Y2584.91 
N1217G3X711.28Y2610.30I701.79J2599.3
3 
N1218G1X694.27Y2625.01 
N1219G1X729.23Y2716.01 
N1220G2X798.61Y2881.69I3546.85J1633.
48 
N1221G1X825.19Y2882.74 
N1222G3X834.78Y2907.57I824.61J2897.2
3 
N1223G1X818.17Y2923.89 
N1224G2X847.21Y2983.59I3546.87J1633.
48 
N1225G2X1121.02Y3216.25I1257.20J277
8.55M05 
N1226G99 
& 
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APPENDIX – II 

G & M CODES 
 

G – Functions 
 

Code Function 
G00 positioning (rapid traverse) (M,T) 
G01 linear interpolation (feed) (M,T) 
G02 circular Interpolation CW (M,T) 
G03 circular Interpolation CCW (M,T) 
G04 dwell, a programmed time delay (M,T) 
G05 unassigned 
G06 parabolic interpretation (M,T) 
G07 cylindrical diameter values (T) 
G08 programmed acceleration (M,T) 
G09 exact stop check (M,T) 
G10 data setting 
G11 data setting mode cancel 

G14 - G14.1 used for scaling (M,T) 
G15 - G16 polar coordinate programming (M) 

G15 - G16.1 cylindrical interpolation - c axis (T) 
G17 XY plane selection (M,T) 
G18 ZX plane selection (M,T) 
G19 YZ plane selection (M,T) 
G20 input in inch 
G21 input in mm 
G24 single-pass rough facing cycle (T) 
G28 return to reference point (M,T) 
G29 return from reference point (M,T) 
G30 return to alternate home position (M,T) 
G33 thread cutting, constant lead (T) 
G34 thread cutting, increasing lead (T) 
G35 thread cutting, decreasing lead (T) 
G38 measure dia. and center of hole (M) 
G40 cutter compensation cancel (M) 
G41 cutter compensation left (M) 
G42 cutter compensation right (M) 
G43 cutter offset, inside corner (M,T) 
G44 cutter offset, outside corner (M,T) 
G45 tool offset decrease 
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G46 tool offset double increase 
G47 tool offset double decrease 
G48 scaling off 
G49 tool length compensation cancel 
G50 tool offset increase 

G50.1 cancel mirror image (M,T) 
G51.1 program mirror image (M,T) 
G52 offset axis w/ respect to 0 point (M,T) 
G53 motion in machine coordinates (M,T) 
G54 work coordinate system 1 select 
G55 work coordinate system 2 select 
G56 work coordinate system 3 select 
G57 work coordinate system 4 select 
G58 work coordinate system 5 select 
G59 work coordinate system 6 select 
G60 single direction positioning 
G61 exact stop check mode (M,T) 
G62 reduce feed rate on inside corner (M,T) 
G64 cutting mode (M,T) 
G65 custom parametric macro (M,T) 
G67 stops custom macro (M,T) 
G68 coordinate system rotation ON (M) 
G69 coordinate system rotation OFF (M) 
G70 inch programming (M,T) 
G71 metric programming (M,T) 
G72 circular interpolation CW (M) 
G72 finished cut along z-axis (T) 
G73 peck drilling cycle (T) 
G74 counter tapping cycle (M) 
G74 rough facing cycle (T) 
G74 cancel circular interpolation (M,T) 
G75 circular interpolation (M,T) 
G76 fine boring 
G80 canned cycle cancel 
G81 drilling cycle, no dwell (M,T) 
G82 drilling cycle, dwell (M,T) 
G83 deep hole, peck drilling cycle (M,T) 
G84 right hand tapping cycle (M,T) 

G84.1 left hand tapping cycle (M,T) 
G85 boring, no dwell, feed out (M,T) 
G86 boring, spindle stop, rapid out (M,T) 
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G87 boring, manual retraction (M,T) 
G88 boring, spindle stop, manual ret. (M,T) 
G89 boring, dwell and feed out (M,T) 
G90 absolute dimension input (M,T) 
G91 incremental dimension input (M,T) 
G92 set absolute zero point (M,T) 
G93 inverse time feed rate (M,T) 
G94 per minute feed (M,T) 
G95 per revolution feed (M,T) 
G96 constant surface speed control (T) 
G97 stop constant surface speed control (T) 
G98 return to initial point in canned cycle 
G99 return to R point in canned cycle 

 
M – Functions 

 
Code Function 
M00 Stop program 
M02 End of program 
M03 Spindle clock wise rotation 
M04 Spindle counter clock wise rotation 
M05 Stop spindle rotation 
M06 Tool change on spindle 
M08 Start coolant 
M09 Stop coolant 
M19 Stop in spindle position 
M20 Axis lubrication manual command 
M21 Head lubrication manual command 
M22 Vacuum table activation 
M23 Vacuum table deactivation 

M30 End of program and rewind the 
program 

M48 Reset M49 
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